
CHAPTER 'I 

Graphics and 
Multimedia in Web 

Portfolios 

One thing that makes web portfolios so much more powerful than 
paper portfolios is their ability to incorporate multimedia elements­
pictures, sound, and even video. These elements give you an opport u ­
nity to communicate some ideas much more directly and vibrantly than 
with text alone. They also make web portfolios exciting and interesting 
to look at. 

Imagine that a student wants to include his research paper on 
developments in the U.S. federal health care system in his web portfo­
lio. The text of the research paper will probably be the most important 
element, but some information, such as statistical data, is easier to 
explain in graphics than in words. For example, the student might 
choose to include a line chart showing the rise and fall in federal expen­
ditures for Medicare and Medicaid in the last ten years. And for his sec­
tion on the Clinton-era health care initiatives, he might want to insert 
a photograph of the former president. These graphics would help the 
audience to understand the student's research by visualizing informa­
tion rather than just reading about it. 

The possibilities for graphics and multimedia in web portfolios are 
tremendous, and using basic graphics isn't very complicated or difficult. 
But the more ambitious your multimedia plans, the larger the invest­
ment in time, training, and money you may have to make. In particu­
lar, negotiating between the different technologies and standards for 
sound or video can be challenging. 
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This chapter will give you a sense of the possibilities for graphics and multimedia in web portfolios, including some techniques you'll need to modify, create, and include basic graphics. For complicated multimedia projects with on-line audio and video, however, you need to investigate what support your school can provide. Fortunately, most schools and universities have made considerable investments in hard­ware, software, and expertise to help students and teachers use multi­media technologies. This chapter also covers copyright, because it's important to use borrowed multimedia ethically and legally. 
Graphics, Multimedia, and Copyright Perhaps the easiest way to include graphics and multimedia in a web site is to download prepared graphics, video, or audio from the Web. Many web sites offer free clip art graphics or sound files that others can use without charge. 1 But when borrowing graphics or multimedia from the Web, you must respect the rights of the people who worked to create those materials. These rights are particularly significant to creating web portfolios because the Web makes it easy to copy, download, or borrow whole works from other authors. The Web also makes publishing easier than ever before. Saving borrowed material to a Web server does not just copy it but in effect republishes it for the rest of the world to see. Under current law every created work is considered copyrighted unless the author explicitly says it's available for public redistribution. Only under specific circumstances-usually called fair use--is it legal to borrow mate­rial created by someone else and use it for your own purposes. Fair use is a notoriously difficult issue because U.S. copyright law doesn't define it very specifically. However, the law does give four basic tests to help courts determine whether the way a work has been used can be called fair. Fair use depends on balancing four criteria: 1. The purpose and character of the use, including whether the use is commercial or nonprofit 2. The nature of the copyrighted work 3. The amount and substantiality of the portion used in relation to the copyrighted work as a whole 
1These sites will usually say whether you are allowed to use their graphics and under what 
terms you can include them in your own web site. This information is frequently indi­
cated by a link labeled "Terms of Use." Be sure to follow their requirements. 
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4. The effect of the use upon the potential market for or value of the copyrighted work (Consortium for Educational Technology in University Systems). Notice that these principles don't say specifically how much or what can be borrowed from other authors-they just give some basic areas in which decisions must be made before determining fair use. This book can't tell you exactly whether including borrowed material in your web portfolio is fair use. But fortunately, the four fair use tests are relatively easy to apply to academic web portfolios, because the statute states that borrowing materials "for nonprofit educational purposes" - for learning, rather than for selling-is gen­erally considered fair use. The Conference on Fair Use (CONFU), which was formed in 1994 as a forum for academic institutions to develop common copyright standards, also suggests that students can generally use materials (particularly digital graphics) with consider­able leeway: Students may do the following: • Use digital graphics in an academic course assignment· such as a term paper or thesis, or in fulfillment of degree requirements. • Publicly display their academic work incorporating digital graph­ics in courses for which they are registered and during formal cri­tiques at a nonprofit educational institution. Retain their academic work in their personal portfolios for later uses such as graduate school and employment applicatiot1s {Harper). These guidelines suggest that including borrowed material in an academic or potentially even a professional web portfolio would count as fair use. After all, academic web portfolios are generally created for courses and for assessment ("formal critiques"), and professional web portfolios are frequently used to develop employ­ment opportunities. But CONFU guidelines are not legally binding-not even all uni ­versities ascribe to  them-and CONFU itself states, "other student uses are outside the scope of these guidelines and are subject to the four-factor fair use analysis" {Harper). The other tests can also weigh against calling a use fait� even if it is for academic purposes. For example, if a student were to republish all of someone else's article, essay, artwork, or web page in his own academic web portfolio, or if that republication caused 
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people to come to the student's site rather than to the original author's, the student might be infringing on the third and fourth fair use tests (he is borrowing a whole work, not just part, and he is discouraging peo­ple from going to the original site, which may be the livelihood of the author). So what can you borrow from the Web to include in your web portfolio? To a large extent, that depends on the situation. If you create the web portfolio solely for a class or academic program in which you are enrolled, you could have a considerable amount of certainty that you can borrow without infringing on copyright. However, if you design the web portfolio to make money, you would have less freedom to use borrowed material. If the web portfolio borrows only small amounts of any given work, such as quotations, the use is less likely to infringe on copyright-especially if you comment or critique the bor­rowed work. However, if the web portfolio borrows a whole work, such as an entire web page, essay, or graphic, the use is less likely to be con­sidered fair. If the creator of the borrowed work explicitly says the work can be copied or used for other purposes, using the work is generally considered fair as long as you stay within the creator's stated terms of use. If the web portfolio includes dip art you have purchased (for exam­ple, along with a software program or a computer), the purchase price is usually considered a licensing fee for using the clip art. But most clip art comes with a license that explicitly spells out what conditions the creators have set for people to use their work, and the purchaser of the clip art must follow those conditions.2 Regardless of your situation, consider the four fair use tests care­fully before borrowing works from another author. If you're in doubt about whether a use is fair, it's a good idea either to avoid using the borrowed work at all or to get permission from the owner. Written permission is best, but even oral permission would show that you had tried in good faith to use the work fairly. If you do borrow graphics or other materials from web sites, document these materials much as you would paper sources. Refer to the documentation manual most often used in your profession for details on documentation require­ments for Internet sources {and see the section on documentation in web portfolios on pages 52-54). 
2Note that the suggestions in this section are not intended as a sanction of using any par ­ticular borrowed work. If you are unsure of the legality of using borrowed material, it's best to avoid doing so. 
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In practice, however, sometimes it's easier to find some other solu­tion besides borrowing people's work. A web portfolio, after all, is sup­posed to be a showcase of your work, not of someone else's. And you can publish your own work however and wherever you like. 
Graphics 

Graphics is a broad term used to encompass a variety of visual images that might be included in a paper or electronic publication. Graphics are flexible and useful ways to convey information. They can include both text and pictures; they can be based on photographs or on draw­ings; they can show statistical or numerical data; they can represent things that people can't normally see -such as the inside of a working automobile engine. There are four basic kinds of graphics you may want to include in your web portfolio-illustrations, information graphics, decorative graphics, and identity graphics: Illustrations are generally photographs or drawings that give readers a representa­tive picture of something a writer has dis­cussed in the text. For example, a research paper on the Reverend Martin Luther King, Jr. might include a photo­graph of the leader, or a profile essay on a local charity might include a photograph of its staff or offices. Illustrations don't generally convey much quantifiable information-they just show readers what something looks like. • Information graphics are usually 
� !:!g;:;ht :,c::::e;�::t:::��� i,:;:::�: 11.;. (\ ships. For example, a research project ;1 / \_ based on a survey might include a line chart showing the bell curve of responses to a question, or a research paper on the Tet Offensive in the Vietnam War might include a map of troop movements. Infor­mation graphics in particular should also be integrated tightly with text-the words and graphics should support and explain each other so readers will understand the content better. 
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• Decorative graphics don't convey information or illustrate anything in particular-they just dress up the page. Most clip art fits this category. Users fre­quently include too many decorative graphics or include clip art that doesn't really fit their needs. Sometimes, though, decorative graphics can effectively set the mood or tone of a web site, giving readers a particular feeling about it. For example, if a web portfolio includes lesson plans for an ele­mentary education class, the author may want to decorate the site with graphics associated with childhood or the classroom, such as building blocks or a chalkboard. ,a,,.,;,,,,,,,,;" '" ,.,. "' "'"" , •• ;,., .a 1'111'1 to indicate the identity of the author. These AC.ME graphics frequently appear in corporate letter-heads, for example, or at the top of every page in a web site. 
Choosing what kind of graphic to use depends on a combination of the information in the web portfolio, the feeling or ideas you want readers to have about the portfolio, and the impression you want to con­vey. The key is to match the choice of graphics to the reader's needs and expectations. For example, if an artifact in your web portfolio includes a description of a physical object, it can be a good idea to include an information graphic-a diagram would help people see how the object looks, what its parts are, and how it works, If an artifact includes a dis­cussion of numbers and statistics, a table or chart might be useful so readers can hold all that information clearly in mind. Every field has different practices concerning how to use graphics. For the best guide, look to publications in your own field for examples of useful and pro­fessional graphics and where to use them. Graphics should be used with care, however; they are powerful and can easily be distracting. If a web portfolio includes graphics the audi­ence doesn't need, the graphics will just become visual noise they will have to filter out before finding the content and ideas. If a web portfo­lio includes a graphic and its purpose or relationship to the content is ambiguous, contradictory, or unclear, the graphic may distract the audi­ence from the content. Even if readers do successfully look beyond the distraction, they will be less likely to pay attention to the content and to feel positive about it. 
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Think through your reasons for including a graphic. If you decide to use a graphic just because it seems appealing, you may want to recon­sider. But if the graphic will enhance the audience's understanding of or attitude toward the web portfolio, considering including it. The fol­lowing sections lay out some background information and techniques for modifying or creating graphics to use in your web portfolio. 
Graphics File Types Chapter 1 described how graphics on web sites are always separate files loaded after the browser receives the basic HTML web page. Although web browsers can display many types of graphics files, almost all graph­ics files on the Web are one of two types. Both of these file types com­press graphics so they'll take up a smaller amount of disk space, making them easier to store and faster to convey over the Web: • JPEGs, known by the file name extensions of .jpg or .jpeg, were named for the Joint Photographic Experts Group, which devised the compression standard. JPEGs are particularly useful for com­pressing photographs and other graphics that have a large number of colors and variations of shading. JPEGs compress graphics by throwing away some of the image information. Most graphics pro­grams allow users to adjust the quality of JPEGs from I (low) to 10 (high); higher quality means a better picture with less loss of image information but a bigger file that tal{es longer to download. Most designers try to compromise between file size and quality, cre­ating the smallest possible graphic that still looks acceptable. • GJFs, known by the file extension .gif (Graphic Interchange For­mat), create small files from graphics that have large areas of a lim­ited number of colors. GIFs compress images by including a single description of each color in the image and a record of which pix­els in the image should be that color. Many logos, drawings, and cartoons include as few as a dozen or so separate colors, so they're good candidates for being saved as GIFs. GIFs can only represent 256 individual colors at a time, which can lead to abrupt transi­tions between colors. So GIFs can include antialiasing, or a pattern of pixels that softens the transition. GIFs can also include trans­parent areas; for example, an image of an oval navigation button is actually a rectangular GIF with the area outside the oval rendered transparent so the background of the web page shows through. 
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Almost every graphic you might download from the Web will already be saved either as a JPEG or GIF. If you create custom graph­ics, however, you will need to save the graphics in JPEG or GIP format before using them in a web portfolio. Many graphics programs, such as Adobe Illustrator, Adobe Photoshop, Macromedia Freehand, Macro­media Fireworks, Microsoft Image Composer, and JASC Paintshop Pro can save or export graphics as a JPEG or GIF. 
Color in Web Graphics Before going into the practical steps for capturing, modifying, or making graphics, it's a good idea to have an understanding of the lim­itations of color in graphics prepared for the Web. Most computer monitors can display thousands or millions of colors at a time, but most web designers try to limit the number of colors used in web graphics. The first reason for doing so is file size: the number of indi­vidual colors in a graphic affects how much the graphic can be com­pressed because the file must include data to describe every color in the image. The second reason is the lack of color consistency from monitor to monitor. Apple computers and Windows computers use different standards for describing color, so what looks fuchsia on an Apple might come out bubble gum on a Windows machine. And every different model and type of monitor displays colors slightly dif­ferently. As a result, many web designers try to restrain their graph­ics to a palette of 216 web-safe colors that will reproduce reliably on most monitors. The reason it's 216 colors requires some explanation. Most peo­ple know the primary colors as red, yellow, and blue; all other colors are mixed from these primaries. However, these colors work as pri­maries only on paper, where light coming from some other source bounces off the paper and is reflected into the viewer's eye. A computer monitor works differently-by making phosphors (or liquid crystals) in  the screen glow, thus making light come from the monitor itsel£ This luminous (as opposed to reflective) color changes the way colors interact, changing the three primary colors to red, green, and blue, or RGB. These colors are usually referred to as additive colors, because if all three colors are added together at full strength, the result is white. (This effect is what makes a scratch on window glass appear white­the scratch mixes together all of the colors oflight coming through the 
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glass, making white.) Removing all of the additive colors, on the other hand, creates black.3 In a computer monitor, additive colors work through pixels. Each pixel on a typical computer monitor contains three phosphors, or crys­tals-one red, one green, one blue-that are made to glow more or less brightly. The mixture or relative strength of these three colors malces all of the millions of colors most computer monitors can show. The strengths of these colors can be set in steps from 0 (none or off) to 255 (full). Setting red, green, and blue to 0 results in black {no color, because all of the pixels are off); setting all of the colors to 255 results in white {all colors mixed together at full strength). Between those extremes, these numbers can represent millions of possible color combinations. Setting red and blue to full (255) and green to off (0) results in a bright purple; setting green and red to full and blue to off is a bright yellow; setting green and blue to full and red to off makes a bright aqua. If you mix in all three colors at various strengths, you can make more colors and intermediate levels of brightness (the higher the numbers, the brighter the image, because the pixels are getting closer to fully on). If all of the colors are at the same level, you get various shades of gray. Computer designers initially devised this system because it allows for precise use of color and fits with the digital way computers work. That precision also fits in well with the limitations of the Web, which needs a consistent, but limited palette of colors that most computers can agree upon. Limiting the number of possible settings on the scale of0 -255 to half a dozen major strengths creates a smaller subset of the millions of possible colors. If you take the numbers from 0-255 and divide them in five equal groups, those groups would be 0-50, 51-101, 102-152, 153- 203, and 204-254, leaving 255 at the top of the range. Taking the first number from each group, there are six positions for the strength of colors: 0 (off), 51, 102, 153, 204, and 255 (full on). These six positions form the basic settings for RGB values in the Web palette, making six possible strengths for red, six possible strengths for green, and six possible strengths for blue. When the possible combinations of these six possible strengths for the three colors are added up, the result 
38y corollary, reflective colors are also called subtractive, because subtracting all of the colors leaves white- just the opposite of the case with additive colors. Think of it this way: if you subtract all of the colors, the white of the paper shows through. Adding all of the subtractive colors together makes black (or something dose to it). 
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is 6 (red) times 6 (green) times 6 (blue), or 216-the number of colors in the standard web palette.4 To see a list of the colors in the web-safe palette, see the book web site. By using this palette of colors consistently, you can have confidence that the colors in your design will look compatible on most readers' machines. Moreover, limiting the colors to this standard web palette typically keeps file sizes small. By sticking with the web-safe RGB val­ues, you can use the color picker in Composer and other web page edi­tors to make sure your backgrounds and text colors are web-safe. But to make graphics web-safe, you'll need a graphics program such as Adobe Photoshop. Photoshop allows you to apply the web palette or other limited palettes to an image using this procedure: 1. Open the image in Photoshop. 2. Click on the Image menu, scroll down to Mode, and click on Indexed color. 3. From the dialog box that pops up, set the palette to Web. This will change the color of every pixel in the image to the nearest web-safe color. However, it's usually a good idea to make this transfor -
4This scheme is  complicated somewhat by the fact that HTML uses a different, but pa r ­
allel, numbering scheme to represent RGB values a s  hexadecimal numbers. Netscape 
Composer 6 requires using these hexadecimals to specify colors precisely; Hexadecimal, 
or hex, just means that instead of numbering in tens, HTML records RGB values in six­
teens: the ten standard digits (0, l ,  2, 3, 4, 5, 6, 7, 8, and 9), plus A, B, C, D, E, and F. 
The lowest setting, 0, still means off, and the highest setting, F, still means full on. These 
correspond to the six settings for RGB values as follows: 

RGB 0 51 102 153 204 255 

Hexadecimal 00 33 66 99 cc FF 

So the color white, represented by the RGB values 255, 255, 255, would have a hex 
value FF, FF, FF. A full blue in RGB would be 0, 0, 255; in hex, it would be 00, 00, FF. 
And a light yellow would be a combination of blue and green, with some red added: RGB 
153, 255, 255, or hex 99, FF, FF. Several tools and charts make it possible to transfer col­
ors easily between RGB values and hex values. For example, since version 6, Photoshop 
has included hex values in its color picker; when you set a particular RGB value, the hex 
value is automatically changed to match. See the book web site for links to several on-line 
color conversion tools as well. 
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mation after you have completed all other alterations to the graphic, such as cropping, resizing, or filtering, because a considerable amount of color information is lost in the process. If you know the kind of monitors on which the audience will view your web portfolio, you have much more freedom to use more colors. In addition, if the web palette will mar the image too drastically-and particularly for photographs, it sometimes does-web designers fre­quently compromise by using one of the following restricted palettes instead: 

Exact, which includes only color information for the colors actu­ally used in the image. • Adaptive, which is a subset of the most commonly used colors in the image. • Perceptual, which includes most of the colors the human eye can see most easily. 

Mac OS, which includes the 256 colors standard on Apple com­puters. • Windows, which includes the 256 colors standard on Windows computers. All of these limited palettes will reduce the file size of the image, but they won't necessarily ensure that the image will be seen the same way on different monitors as the web-safe palette does. 
Capturing Graphics The first challenge of preparing graphics for the Web is to get them in a digital format so they can be adapted or modified for use in a web page. If you create the graphics digitally to begin with, you can avoid this challenge; see the section on "Creating Original Graphics" begin­ning on page 113 for more information. But if the graphics are in some other format, you need to capture them as a digital image before you can get them ready for presentation on the Web. Two convenient tools for doing so are digital scanners and digital cameras. 
Scanninj Graphics If you already have graphics on paper but would like to include them in your web portfolio, scanning can be the answer. Using a scanner isn't much different from using a photocopier, except 
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that the scanner translates the paper image into a digital image you can save or manipulate on a computer. Be sure to assess the copyright sta­tus of graphics you are considering scanning; copyright applies to printed as well as electronic material (see Graphics, "Multimedia and Copyright" on page 88). The biggest choices you must make before scanning the image are what resolution and color depth to use. Resolution refers to the num­ber of dots per inch (dpi) of the scanned surface the scanner will record. A higher resolution makes for a higher quality of picture with smooth transitions between colors, but it also creates a larger file. Lower reso­lutions create smaller files but can make the image look grainy. Color depth refers to the number of colors the scanner will record-on most computers and scanners, this depth ranges from 2-bit (black and white) to 32-bit (millions of colors). Because readers don't like to wait very long to download graphics, however, most web designers compromise between resolution, color depth, and quality, using the lowest resolu­tion and color depth that still looks acceptable. A further complication arises because web pages are viewed on computer monitors, which have a low screen resolution. If you open an image scanned at 300 dpi on a computer monitor that only has 100 pix­els per inch (ppi), the image will seem three times larger-the computer will translate each dot of the 300 dpi scan to one pixel of the JOO ppi monitor. So an image one inch on each side will actually appear as hav­ing three inches on each side; in area, this image will be nine times big­ger (three inches by three inches is nine square inches, whereas the original scan was only one square inch). The image will then need to be resized to fit the needs of the web page. There are two ways to approach this situation. If you have a rela­tively good scanner and a powerful, fast computer with lots of memory, it is a good idea to scan graphics initially at a high resolution, then use Photoshop or another image editing program to shrink the image to size. This approach takes longer, but it frequently yields better results because it gives more data to work with in the image. However, on less powerful computers or in situations where time is short, you can create relatively good-looking graphics from scans using a lower resolution that matches the typical resolution of computer screens. The general rule of thumb for scanning graphics directly for the Web is to use an average figure of 72 dpi on Apple computers and 96 dpi on Windows. Similar choices apply to color depth, but it's usually best to scan in more colors and reduce the colors later when saving the image as a GIF or JPEG. 
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Every scanner has its own proprietary software to perform the scan­ning process, so refer to your scanner's documentation before proceed­ing. But in general, the process goes like this: 1. Place the paper graphic on the scanner plate and close the lid. 2. Open the scanner software and direct the scanner to scan a preview image (usually by clicking a button labeled Scan ot Preview). This preview image shows up in the scanner software window after a few seconds. 3. Use the scanner software options to modify the scan settings, including color depth (black and white, grayscale, thousands of col­ors, and so on), resolution, and output size. 4. Direct the scanner software to scan the final image. Usually, when it's donei the scanner software will show you a Save & dialog box so you can set where the scanner will save the final image and what file type it should use. The default file type is usually bitmap (.bmp), so to use the graphic directly in a web portfolio, change the file type to GIF (for a drawing) or JPEG (for a photograph). But if you are going to edit the image further, save it as a bitmap and change it to GIF or JPEG format later in an image editing pro­gram such as Photoshop. After you've scanned the image, you can open it in an image edit ­ing program) where you can crop it, resize it, sharpen iti or export it as a GIF or JPEG (see "Modifying Graphics" below for more infor­mation). Many scanners also come with a bare-bones image editing program bundled with the scanner software that can do many of these common tasks. You can also generally use the Import command in your image editing program to run the scanning process (in Photoshopi Import is under the File menu). This command simply opens the scanner soft ­ware so you can perform the procedure outlined above and then auto­matically returns you to the image editing program so you can work on the image there. 
Using Digital Cameras Digital cameras can be useful in creating web portfolios. For example, education students might want to include a digital photograph of themselves directing a class during their student teaching program , or students in the sciences or engineering might want to take a photograph of an experiment or design. Digital cameras are 
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also becoming relatively inexpensive and common; your school may own one you can borrow. Taking a photograph with a digital camera is typically much like using an automatic film camera-just turn on the camera, point, and shoot. But be sure to refer to your camera's manual for specific instruc­tions. Many digital cameras include display panels so you can review the photographs immediately after taking them. These panels also let you delete unwanted photographs-usually a good idea, because the camera's memory can hold only so many. Most digital cameras also let you specify the quality of the image before taking it. Lower quality means a smaller graphics file size but less resolution and color depth. Digital cameras usually store graphics on internal memory or a small removable card or disk. 11-ansferring the photographs from the digital camera to a computer usually involves plugging a cable between the camera and computer and using computer software that came with the camera to complete the transfer. This software is different for each brand, so refer to the user documentation that came with the camera to perform the process. If your camera has a removable card or disk, you can also typically eject the card or disk and insert it into an appropriate drive or reader attached to a computer. Most digital cameras automatically save photographs as JPEGs, so you won't have to use an image editing program to change the graph­ics file type. However, you may want to use an image editing program to clean up, crop, or resize the photographs for use in a web portfolio (see the following section for general instructions on doing so). 
Modifying Graphics Once you have captured a graphic in digital format, you can use image editing software to modify it for use in a web portfolio. The three most common modifications to graphics are to crop, resize, or adjust the color and contrast. After making these changes, you can optimize the graphic for the Web by saving it as a GIF or JPEG. The instructions in the sections that follow focus on Adobe Pho­toshop TM, the most commonly used image editing program. However, several other programs, including Paintshop Pro TM and Microsoft Image Composern,.I, can do similar procedures; see the book web site for further software suggestions. When you open a JPEG or GIP image in Photoshop to make mod­ifications, be sure to change the image to RGB mode by clicking on Image: Mode: RGB Color (bitmaps should load with this mode 
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already). This step allows Photoshop to use many more options and col­ors than JPEG or GIP can handle. You can save the graphic as a JPEG or GIF again when you have completed your modifications. 
Cropping Cropping refers to the process of selecting a rectangular por­tion of an image and discarding the rest. Cropping photographs of peo­ple is a particularly good idea because it can focus attention on the people rather than the background. The smaller image size also retains a higher image quality without making the file too large. To crop an image in Photoshop, follow this process: 1. Open the image in Photoshop. 2. Choose the Rectangle Marquee tool from the toolbar. Its button has a picture of a rectangle with a dashed line. 3. Move the cursor over the image (the cursor will appear as a crosshair). 4. Click and hold down the mouse button at the upper left-hand cor­ner of the rectangular area you want to keep. 5. Drag the cursor right and down until the dashed line makes a rec­tangle around the area you want to keep, then let up on the mouse button. The dashed rectangle should stay visible. 6. To move the rectangular area, click and drag inside the dashed lines. If the rectangle came out the wrong size and you'd like to try again, press CTRL-D (Command-D in Apple OS) to deselect the selected area, then repeat steps 4 and 5. 7. Click on the Image menu and choose Crop. The area outside the dashed rectangle will be discarded. If you accidentally cropped an area you meant to keep, choose Undo from the Edit menu or press CTRL- Z  (Command-Z on Apple OS), then try again. 
Resizing Whereas cropping changes the size of the image by throw­ing away part of the picture, resizing changes the size of the entire image at once. To resize an image in Photoshop, follow this process: 1. Click on the Image menu and choose Image size . . . .  2. Set the resolution to the number that fits your needs. The typical rule ­of-thumb resolution for web development is either 72 or 96 dpi. 
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3. Set the pixel dimensions to the width and height you would like. By default, changing the width will automatically change the height and vice versa, so the aspect ratio (the relationship between width and height) stays proportionate. 4. Click OK to apply the changes to the image. One good indicator of the size you should make an image is the size of the layout table cell in which the image will be loaded. Make sure to resize your graphics so they will fit in the layout table cells provided for them; otherwise, rhey might throw off your layout because the cells will expand to accommodate the graphic. 
Adjuslinj Color, Brijhtness, and Contrast Scanned or digitally pho­tographed graphics typically have problems in color and contrast. For­tunately, most image editing programs allow quick modifications to adjust these factors and improve the appearance of the image. Some consumer or hobbyist applications, such as Kai's PhotoSoap, actually come with step-by- step wizards to help you through the process of improving images. For more control, however, Photoshop is currently the best option. The easiest way to adjust color and contrast quickly in Photoshop is to open the image and choose Image: Adjust: Auto Levels. This com­mand automatically adjusts the highlights and shadows of the image, thus smoothing out and intensifying color, brightness, and contrast. Typically, Auto Levels will brighten areas that are too dark, darken areas that are too light, and make colors look more vibrant. Photoshop also includes an Auto Contrast command that adjusts contrast to a prede­termined average level (Image: Adjust: Auto Contrast). If you want closer control, you can also use the Brightness and Contrast dialog box (Image: Adjust: Brightness and contrast). This dia­log box contains two horizontal sliders, one for increasing or decreas­ing brightness, the other for contrast. Similarly, the Color Balance dialog box (Image: Adjust: Color balance) allows adjusting the precise strengths of red, green, and blue in the image. You can also make color changes individually to the highlights, midtones, or shadows in the image. To change the color range of an entire image� for example, to make a photograph sepia-toned� use the Hues/Saturation dialog box (Image: Adjust: Hues/Saturation). Click on the Colorize checkbox, then move the hue slider left or right to change the overall tone of the image 
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to the color you want. If you also check the Preview checkbox, Photo­shop will show you the effect of your changes on the image itself as you make adjustments. 
Optimizing Graphics for the Web After you have captured an image digitally and modified it to suit your needs, you can optimize it for the Web by saving it as a compressed image, such as a GIF or JPEG. As noted earlier, GIFs are typically used for graphics with relatively large expanses of a limited number of col­ors, such as drawings, logos, or cartoons. JPEGs are typically used for graphics with smooth gradations of color, such as photographs. How­ever, web designers experiment with file types and settings to get the best trade-off between quality and file size. Sometimes a photograph works best as a GIF and a drawing works best as a JPEG. The following sections will introduce you to the procedures for saving GIFs and JPEGs using Photoshop, but many other programs can do the same thing. See the book web site for more information on alternative software. Starting with Photoshop 6.0, image opti­mization takes place in a dialog box that lets you set the file type and many associated characteristics of the image (see Figure 4.1). Access 

FIGURE 4.1 Photoshop Save for Web Diahg Box 
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this dialog box by choosing Save for Web in the File menu. In the Save for Web dialog box, Photoshop displays the original image and three potential optimized versions you can modify to compare dif­ferent optimization settings. Below each version, Photoshop lists the file size and average download time for the image if it were to be saved to that optimization. 
Saving Files as JPEGs To save a file as a JPEG, first open or capture the image and make any necessary modifications to its size, resolution, color, brightness or contrast (see "Modifying Graphics" above). Then choose Save for Web . . .  from the File menu. The Save for Web dialog box will appear, showing four possible versions of your image includ­ing the original in the upper-left corner and three potential optimiza­tions. (If you don't see the four possible versions of the image, click the 4-up tab at the top of the dialog box.) You can set each of the three optimized versions with different settings, allowing you to compare how the settings will affect image quality and file size. To change the settings for one of the versions, first click on the version you want to change, then use the options to the right to specify optimization settings (see Figure 4.2). Holding the cursor over an option will bring up a short explanation of what the option does. Among the possible settings to experiment with are the following: 

File fa,mat. Set the file format to JPEG using either the Settings drop­down menu, which provides a variety of preset JPEG optimizations, or with the Optimized file format (down and to the left of Settings) menu, which allows you to set JPEG in general and make further specifications. If the file format was originally set at GIF, however, changing the file format directly to JPEG will result in a poor image (the JPEG is made from a GIF, rather than from the original image). To overcome this problem, dick on the Settings drop-down menu to change the image first to Original, then to one of the JPEG options. 
Quality. Set the quality of the JPEG either to generic settings of Low, Medium, High, or Maximum, or set the quality to a specific number between O and 1 00. 
Progressive. Selecting this option will make a web browser load a lower-resolution JPEG image first, then the full resolution. Leav­ing the option unchecked means the browser will have to down­load the entire image before showing any of it. 
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FIGURE 4.2 JPEG Options in Photoshop Save for Web Dialog Box 

Optimized. If you know the web portfolio will be viewed in a rel­atively new browser, choose this option. It makes the file size slightly smaller by using a newer JPEG standard. • B/u,: Sometimes slightly blurring a low-quality JPEG will improve the appearance of the graphic. Choose a higher number to blur the image more. Experiment with a variety of settings using all three of the opti­mized graphics, then compare them for the best compromise between appearance and file size. When you make a decision on which to choose, click on the version you want and click the OK button to save the image to your resources folder. 
Saving Files as GIFs Saving an image as a GIF involves the same tech­nique used for a JPEG but with different kinds of optimization settings. To save an image as a GIF, first use Photoshop to make all modifica­tions necessary to adjust the size, resolution, color, brightness, and con­trast of the image. Then click on the File menu and choose Save for Web. The Save for Web dialog box will appear, showing the original and three different optimized versions of the image. 
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To change the settings for one of the optimized graphics, click on 
the image to select it, then change the settings on the right side of the 
dialog box (see Figure 4.3). Once again, resting the cursor on one of 
these settings areas makes a description of that setting pop up. First, 
you'll want to change the file type to GIP in the Settings drop-down 
menu, which gives a variety of typical optimization schemes in a vari­
ety of formats (you can also set the file type to a generic GIP in the drop­
down menu just below Settings). Then consider experimenting with the 
following settings for GIP graphics: 

• Palette. As discussed in "Colors for Web Graphics" above, a GIF 
can be set to include only the 216  web-safe colors. This will 
ensure that the colors will reproduce relatively faithfully on 
other monitors. The image can also be set to one of the other 
kinds of palettes discussed: exact, adaptive, perceptual, Win­
dows, or Apple. 

Colors. Even if the image is set to a limited palette, you can still 
limit the colors further. Sometimes reducing the number of colors 
doesn't badly affect the quality of the image, but it can make a con­
siderable reduction in file size. The actual colors in the table are 
listed in the rectangular area below the options. Web-safe colors 
have a small circle in the middle of the color square. 

• Dithe,: Dithering creates a smoother transition between adjacent 
colors in an image. For example, if the two adjacent areas are col­
ored white and black, Photoshop can dither in some gray pixels 
between the areas to soften the transition. Several types of dither­
ing are available, including diffusion, pattern, and noise. Experi­
ment to see which looks best. The slider to the right of the 
dithering drop-down menu can also specify how much Photoshop 
applies dithering between colors. Interlaced. Clicking on this check box creates an image that loads 
in a web browser in several passes so readers can see the progress of 
the download. Leaving the box unchecked means that the browser 
will wait until the image downloads entirely before showing it in 
the browser window. (Interlacing is roughly equivalent to the pro­
gressive setting for JPEGs.) 

Just as with JPEGs, experiment with a variety of settings using all 
three of the optimized graphics, then compare them for the best com-
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FIGURE 4.3 GJF Options in Photoshop Save Jo,- Web Dialog Box 

promise between appearance and file size. When you make a decision on which to choose, click on the version you want and click the OK button to save the image to your resources folder. 
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Advanced Techniques: Filters, Transparency, Text Photoshop and most other image editing programs also allow the user to make sophisticated modifications to graphics by applying filters, making areas of a GIF transparent, or adding text to graphics. The fol­lowing advanced techniques are commonly used in creating graphics for web sites. Because Photoshop is the most common graphics editor used for web development, the instructions below refer to this program, But many other programs can do similar things. Again, be sure to change GIF or JPEG images to RGB mode by clicking on Image: Mode: RGB Color before making further modifica­tions. You can export the graphic as a JPEG or GIF again when you have completed your modifications. 
Applying Filters in Photoshop A filter is a preset command that changes an image or part of an image in a variety of ways-by blurring or sharpening; by adding artistic effects, such as brushstrokes or a water­color; or by distorting the image. Thousands of filters are available for Photoshop, and the program generally comes with a few dozen of the most common. To use a filter, open the image in Photoshop, change the mode to RGB, then choose a filter from the Filter menu. The dialog box will dif ­fer for each filter; experiment to see what effect the filter creates. If you don't like the effect, choose Undo in the Edit menu and try another. Fil­ters can be applied sequentially, one over the top of another. You can also apply a filter to part of an image by first selecting the part you want to work with using the Marquee tool (to create a rectangular or round selection) or the Lasso tool (to draw an irregular selection), then apply­ing the filter. You can apply filters to individual layers in the image by choosing a layer in the Layers Palette, clicking on the filter button at the bottom of the palette (the button has a white "f" on a black circle), and choosing a filter. (For more on layers, see the following sections on adding text and creating transparent GIFs.) 
Adding Text in Photoshop Adding text to a graphic can provide use­ful information and clarify the graphic's purpose. When you add text to a Photoshop image, the program creates a new layer to hold the text. This new layer is superimposed over the original layer, and you can make changes to these layers separately. 
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To add text to a graphic in Photoshop 6 or late1� follow this procedure: 

1 .  Open the graphic to which you want to add text. 

2. Click on the Text tool in the toolbar (it has a "T" on it). 

3. Set the options at the top of the screen for font, font size, font style, 
and alignment. 

4. Set Antialiasing (the drop-down menu to the right of font size) to 
smooth, crisp, or strong- try each to see which you like best. Antial­
ising adds a halo of shaded pixels around the letters so they'll blend 
well with the image; otherwise, the letters will have jagged edges. 

5. Click on the colored rectangle to the right of the alignment but­
tons to set the color of the text. 

6. Click in the graphic where you want the text to appear, and type 
the text. 

7. Adjust the text as follows: 

• To move the text after typing it, dick on the Move tool in the 
toolbar (in the top row, right next to the Marquee tool) and click 
and drag the text where you want it. 

• To delete all of the text, right- dick (Apple: Option-dick) on the 
text layer in the Layers palette and choose Delete Layer. If you 
can't see the Layers palette, click on the Window menu and 
choose Show Layers. 

• To modify the text, click on the Text tool again and click in the 
text to type changes or select text to make changes to font, color, 
or size. 

8. Click on the checkmark button at the top right of the screen to 
commit the changes. 

Each time you add text, Photoshop will add a new layer to the graphic. 
You can rearrange these layers in the Layers palette by clicking and drag­
ging them up or down in the list. When you use Save for Web to optimize 
the graphic as a JPEG or GIF, these layers are collapsed into a single layer. 

MakinJ Transparent GIFs in Photoshop All graphics files are essen­
tially rectangular, but not all images look that way on the Web. For 
example, designers may create oval or odd-shaped bullets or buttons to 
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include on their sites. To achieve this effect, web designers save a rec­tangular image as a GIF and set some parts of the graphic to be trans­parent so the web page background shows through. For example, in Figure 4.4, the turtle is actually a rectangular graphic, but the parts out­side area covered by the turtle are set to be transparent, allowing the background to show through. Different image editing programs use different methods for creat­ing transparent GIFs-and these methods can vary widely, so be sure to check your software's user documentation. Some programs specify that certain colors should be transparent, so designers typically change the color of the area they want to be transparent to a color not used in the visible area. Other programs specify that certain areas should be transparent; Photoshop (version 6 and later) uses this method. Making a GIF transparent in Photoshop involves three stages: creating a trans­parent layer, deleting the area to be invisible, and saving the file as a GIF. 
Stage One: Creating a Transparent Layer 1 .  Open the GIF in Photoshop and set the mode to RGB (dick on the Image menu and choose Mode: RGB Color). 2. Click on the Layer menu and choose New: Layer, then dick OK. A new layer will appear in the Layers palette. (If you don't see the Lay­ers palette, click on the Window menu and choose Show Layers.) 

FIGURE 4.4 1i·ansparent GIFs 



GRAPHICS 1 1 1  

3. Repeat step 2. You should now see three layers in the Layers palette: from bottom to top, they are Background, Layer 1, and Layer 2. Layers 1 and 2 will be filled with a checkerboard pattern to show their transparency (like Layer 1 in Figure 4.5). 4. Click on the background byer in the Layers palette. This layer is where the original image is still set. 5. Press CTRL-A (Command- A  in Apple OS) to select all of the image. 6. Press CTRL-C (Command-C in Apple OS) to copy the image. 7. Click on Layer 2 in the Layers palette and press CTRL-V (Com­mand- V in Apple OS) to paste the image. 8. In the Layers Palette, right-dick (Apple: Option-dick) on the label of the Background layer, choose Delete Layer) and dick Yes. At this point, you should have two layers, Layer 1 and Layer 2; the image should be in Layer 2 (the top layer), and Layer I should be trans­parent {indicated by the checkerboard pattern). 

FIGURE 4.5 T,-ansparent and Background Layers 
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Stage Two: Deleting the Area lo Be /nuisible I .  Click on Layer 2 (the top layer, where the image is loaded) in the Layers palette. 2. Select the area you want to stay visible using one of the following methods. If you make a mistake, deselect by pressing CTRL-D (Com­mand-D in Apple OS) and try again. Afi:er you have made the selec­tion, you can also click and drag on the selected area to adjust it • Click on the Lasso tool in the toolbar and move the cursor to the boundary between what you want to be visible and invisible. Click and hold down, then carefully draw around the area you want to stay visible. "When you get back to the start point, let up on the mouse button to join the beginning and end of the line. • If the area you want to keep has a distinct border or edge, click and hold down on the Lasso tool and choose the Magnetic Lasso. Then click once on the edge of the area you want to stay visible and carefully move the cursor around the edge. The dashed selection line will follow the cursor around the edge, automatically adding anchor points along the way. If the line starts to go astray, click on the edge, which will add an anchor to the line. Double-dick to join the ends. • If the area has a relatively consistent color, click on the Magic Wand tool in the toolbar. Then click on the color you want to select. Photoshop will select all of the pixels connected to the one you clicked on that have a similar color. You can adjust the sensitivity of the Magic Wand by changing the Tolerance setting at the top of the screen (a higher number means the Wand will select a broader variety of colors close to the color you dicked on; a lower number means the Wand will select fewer colors). Add more colors to the selection by holding down the Shift key and dicking on the new colors. 3. Once you have the area you want to keep visible selected, click on the Select menu and choose Inverse. This switches the selected and uns­elected areas so the area you want to be invisible is now selected. 4. Press CTRL- X  (Command- X  in Apple OS) or the Delete key to delete the area to be made invisible. You should see the checker­board pattern of the transparent background showing through the invisible area (see Figure 4.6). 



FIGURE 4.6 GIF with Invisible Area 

Stage Three: Saving the File as a GIF 1. Choose Save for Web from the File menu. 
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2. Click to check the transparency option {if it isn't already checked). 3. If the background of the web page on which the image will appear is a solid color, click on the rectangle beside Matte (which opens a color picker) and choose the general color of the web page background. This will add a smooth gradient of pixels around the visible part of the image to blend between it and the background. If you don't know what the background color will be or if the web page includes <!- pat­terned background, leave the Matte color set to None. 4. Make any optimization choices you'd like, and click OK to export the file as a GIF. When you insert the image into a web page, the image will still be rectangular, but the background of the web page will show through the transparent area. 
Creating Original Graphics The techniques discussed thus far have used premade graphics-either borrowed from someone else or created by a scanner or a digital cam­era. But you can also create your own graphics from scratch. Doing so 
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can be challenging and interesting, and you can create precisely the graphic you need rather than relying on what's already available. Because this process involves a variety of techniques that differ widely from pro­gram to program, it is not possible to cover everything here; but several techniques using Adobe Illustrator TM are explained below. So far, this chapter has covered bitmap graphics programs, so called because they use computer data to describe the appearance of every dot that makes up the image (Photoshop is such a program). These pro­grams are typically better for manipulating graphics after they have been created than for creating graphics from scratch. Vector graphics pro­grams, such as Adobe Illustrator or Macromedia Freehand, describe the appearance of a graphic by reducing its shapes to a mathematical for­mula. Instead of describing each bit of a blue circle, for example, vec­tor graphics programs use math to describe the shape, color, and size of the circle. That way, the program needs only to remember the formula, not all of the information in the graphic. The biggest advantage of vector graphics programs-also known as drawing programs-is that they treat the various elements in an image as objects that can be modified separately. Vector graphics programs can easily manipulate the geometric shapes and text that make up most drawings, and they can create smooth graphics even when the image is scaled to a larger size. To change the size of a blue circle in a vector graph­ics program, for example, you would need only to click on the circle, grab on one ofits handles (little squares that appear on the corners, sides, or edges of the circle), and drag. Newer versions of some bitmap graph­ics programs can do some vectored shapes, but for more complicated drawings, logos, or cartoons, a vector graphics program is the way to go. 
Creating Navigation Buttons A good example of graphics that are easy to make in a vector graphics program are the buttons you might use for navigation in a web portfolio. You can also malce buttons in a bitmap graphics program, but the process is typically more complicated. In Adobe Illustrator, making a button is relatively simple, involv­ing tvvo stages-drawing the button and exporting it as a GIF. First, draw the button: I. Click on the rectangle tool in the Tools palette. {You can choose other shapes as well-just be sure to check the transparency option described in the exporting procedure below.) 
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2. Click on the color you want the button to be in the Color palette. If you don't see the Color palette, choose Show Colors from the Window menu. 3. Click and drag in the drawing area to make the object the size you want the navigation buttons to be. 4. Click on the text tool, click in somewhere in the drawing below or above the button, and type the text you want. 5. Select the text you typed, then use the Character palette if you want to change the font and size. 6. Click on a color in the Color palette that will contrast with the but­ton background. 7. Click on the selection tool (the black arrow) in the toolbar, then click and drag the text onto the rectangle. Adjust the rectangle and text so they're aligned just right. Next, export the button as a GIF. Illustrator will automatically export only the objects you drew; if you drew any extra objects, delete them first so they don't show up in the finished graphic. 1. Click on the File menu and choose Export. You'll see the Export dialog box, which look� similar to a typical Save As dialog box. 2. By the words Save as Type, change the file type to GIF89a. 3. Navigate to your resources folder, type in a file name, set the file type to GIF, and click Save. You'll see GIF89a Options dialog box. 4. In the GIF89a Options dialog box, select the options you want to apply to the button. Be sure to check interlace, which loads the graphic in a series of steps, rather than all at once. If your button is oval or some shape other than rectangular, choose Transparent, which adds transparency around the image. If your burton includes text, choose Antialias, which adds a slight fuzziness to the edges of the letters so they won't look jagged. To mal<.e the next button, just go back to Illustrator, delete the text of the first button, then replace it with the text for the next button you 
FIGURE 4.7 Home Button 
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want to make and export it with a new file name. Repeat this process until you've created all the buttons you need, and all of the buttons will come out the same size. Dreamweaver and FrontPage also include a variety of tools for cre­ating ready-made buttons. For example, in Dreamweaver, you can choose Insert: Interactive Graphics: Flash Button to create an interac­tive menu button you can customize by adding your own words to it. FrontPage allows much the same thing using the command Insert: Active Elements: Hover Button . . .  to create a basic button. However, these methods require additional software demands-for FrontPage, the FrontPage server tools must be loaded on the web server for the buttons to work, and Dreamweaver Flash buttons require users to have installed the Flash plug- i n  in their browser. A variety of on-line graph­ics generating services will also let you create buttons, logos, and page banners. See the book web site for more information about on-line graphics tools. 
Creating Charts Information graphics such as bar, line, or pie charts can be a great way to include numerical data in your web portfolio. For example, if your project web portfolio involves a survey, you could cre­ate a pie chart showing the responses to one of the survey questions. Most vector graphics programs, such as Adobe Illustrator, include tools to create simple charts, but you can also do so easily in Microsoft Excel or Word. To create a pie chart in Word and export it to a web portfolio, for example, follow these instructions: 1. Open a new document in Word and from the Insert menu, choose Object. 2. Under Object type, choose Microsoft Graph Chart. You'll see two items pop into your window: a sample bar chart and a smaller win­dow that looks like a spreadsheet with columns, rows, and cells filled with sample numbers. 3. In the spreadsheet window, delete the sample information Word initially places in the cells and enter your information for the pie chart using Figure 4.8 as a model. A pie chart has only one series of data-the parts that malce up a whole-so these parts are all rep­resented in one row of the spreadsheet. (Other types of graphics can have more than one series; for example, a chart comparing the growth in U.S. and world population over the past ten years would 



FIGURE 4.8 Chart in Microsoft Word 
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have one series for U.S. population and one for world population. In these cases, enter the data for each series on a separate row.) 4. Right-dick (Apple: Option-dick) on the chart, choose Chart type, then change the chart type to a pie chart (or some other type of chart if you have more than one series of data). 5. If you want to, modify the chart by right-clicking (or for Apples, Option-cliclcing) on it and choosing Chart options. The dialog box will let you enter a title, modify the legend, change colors, or add labels to the slices of the pie. To export the pie chart as a GIF, first click in the document out­side of the chart or spreadsheet areas; the spreadsheet will disappear, leaving only the chart visible. Then follow these steps: 1. Click on the File menu and choose Save as Web Page. You'll see the Save As dialog box. 2. In the Save As dialog box, navigate to your resources folder, enter a file name-for example, piechart-and click Save. Word will auto­matically make a GIF of your chart and place it in a folder it cre­ates called piechartjiles in your resources folder. This automatically 
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generated GIP will have a number for its file name-but if you cre­ated only one chart, there should be only one GIF in the folder. Before inserting the chart in your web portfolio, move the GIF file from the [piechart}_files folder up a level into your resources folder, which will make uploading your web portfolio easier. You also may want to rename the file from its automatically generated name to something easier to remember. Then use the standard technique for inserting an image into your web portfolio page as explained in Chapter 3 (page 77). 
Audio and Video Simple graphics add a great deal to a web portfolio, but at times, there's no substitute for video or audio. However, putting audio, video, and the Web together is challenging because the Web supports a variety of competing formats for audio and video. Choosing which format is best for your purposes can be complex. Video also requires specialized soft­ware and hardware priced beyond the means of many students, although your school may have made the investment for you. Before considering audio or video, check out your school's resources. 
Why Use Audio and Video? Audio and video can make a significant impact on the audience view­ing your web portfolio. For audio, rather than merely reading what you have to say, the audience can actually hear you say it. This is particu­larly useful if a web portfolio includes elements that would benefit from a voice-over explanation. For example, if a web portfolio included a pic ­ture or chart that needed commentary, i t  could include a button users could click to hear the commentary while looking at the graphic. It could even start the voice-over automatically as if the web portfolio were a slide show. Audio is also useful for performances, such as in the fol­lowing situations: • A portfolio that includes an analysis of a poem features a record­ing of someone reading the poem. • A portfolio that includes research on endangered songbirds features recordings of the birds' calls. • A portfolio that includes an interview with an expert or celebrity features audio clips of the person's comments. 
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Take care in deciding whether to use audio in your web portfolio. Audio should improve the audiences' experience of the web portfolio) not distract them from the portfolio's content. If you decide to record sound for your web portfolio, plan it out ahead of time; when creating a voice-ovet� for example, it's best to read from a prepared script. Try to keep the length of each audio clip short, because audio files can grow large quickly) and the audience will become impatient if audio files take too long to download. One thing to avoid is endlessly repeating background music-many peo­ple complain about being distracted by this use of audio. Video has similar advantages to audio-it's interesting and vibrant, and it holds great opportunities for actually showing something rather than only telling about it. Consider these possibilities: A portfolio with an editorial on campus parking includes a video of a university parking lot with people vying for spaces on a busy day. A portfolio with teacher training materials includes a video of the author teaching a unit before a classroom. A portfolio with a paper on a contemporary novelist includes video clips of the writer reading from her latest book. The opportunities are limited only by what you can imagine­plus, of course, the inherent limitations of putting video in a computer and on the Web. Using video takes careful consideration in three main areas. First, whereas audio requires nothing more than a relatively inexpensive microphone and software, video requires a video camera-which can be expensive. In addition, for video to be converted to digital format with a computer, the computer must be equipped with a video capture card. Digital video streamlines this process by allowing a direct con­nection between a digital video (DY) camera and a computer through a Fire Wire (IEEE 1394) cable, and many new computers have ports for Fire Wire-in fact, most Apple computers now come with Fire Wire as a standard feature. However, DV cameras are still significantly more expensive and less common than analog video cameras. Second, preparing video for use on the Web requires sophisticated and relatively expensive software such as Adobe's Premiere or Apple's Final Cut Pro, and these programs can be more difficult to learn than typical office software. On the positive side, however, Apple's iMovie, which currently comes with most Apple computers, is free and relatively simple to use for basic video editing. 
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Third, video uses vastly larger amounts of data than does audio. Every pixel in the video file must be recorded, digitized, transmitted through the Web, and replayed as quickly as possible for video to look acceptable. Most people are used to seeing video in the form of films or television, where the frame rate (the speed at which the screen is refreshed with a new image, giving the illusion of move­ment) is usually greater than 30 frames per second (fps) and the image size is relatively large. Accommodating the data for 30 indi­vidual pictures every second quickly overwhelms even the fastest Internet connections, so digital video usually reduces both the frame per second rate and the image size to cut down the amount of data that must be transmitted. The result is that instead of seeing a smooth, full-screen video, users looking at digital video through the Web frequently see a relatively small window (about two inches square is common) that sometimes jerks and skips. If you intend to submit your web portfolio to readers on CD-ROM or over a local network, the digital video can have a larger size and faster frame rate-but if people will view your portfolio over the Web, they may not see exactly what you intended. 
The Web and Audio/Video Files Putting audio and video in a web page involves the same general process, but with many options. In broad terms, the process goes as follows: 1. Capturing. Before you can do anything with audio or video, you have to capture it into a computer with a device, usually a micro­phone or video camera. This generally requires using a computer to digitize the analog information that microphones and most video cameras record. For audio, this usually involves nothing more than plugging a microphone into the computer's sound port. For video, it usually involves attaching the video camera to the com­puter through a video capture card and running the tape so it can be digitized with video editing software. 2. Editing. Once an audio or video dip is digitized, you can use spe­cial audio or video editing software to change its length or size, add special effects, or combine it with other audio or video dips. 3. Formatting. Because you'll be using digital audio or video in a web page, you need to format it so a web browser can read it. This 
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sometimes requires additional software, depending on which of the many formats you choose. 4. Inserting. Most WYSIWYG web page editors can create links to audio or video files; FrontPage and Dreamweaver also have special commands that allow users to insert audio and video into web pages from the editor. This process involves several choices and options, and the spe­cific steps you follow to use audio or video in your web portfolio will depend on the software, hardware, and support available to you. The following sections go into some detail about the options available for audio and video. 
Capturing Audio and Video Before you can do anything with audio or video, you need to get it into a computer in digital format. Doing so requires both a recording device, such as a microphone or video camera, and a computer with the appro­priate audio or video card to digitize the audio or video. 
Capturing Audio Both Windows and Apple computers typically come loaded with sound cards and basic recording software. Usually, this software works almost li ke a tape recorder or VCR-the buttons even look the same. You can also use audio editing software to cap­ture and digitize audio, which has the advantage of giving you greater control over the recording. For example, audio editing software allows you to set the sampling rate, which determines the quality and file size of the sound captured by the microphone. A higher sampling rate means that the computer will record a more accurate version of what the microphone takes in, but it also makes for larger file sizes and thus longer downloads. To record basic audio with a Windows computer, follow these steps: 1. Plug an appropriate microphone into your computer's microphone port. 2. Open the Windows Sound Recorder by clicking on Start: Pro­grams: Accessories: Entertainment {or Multimedia): Sound Recorder. All Windows versions from Windows 95 up include this software. 
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3. Click on the Record button and begin your recording. 4. Click on the Stop button when your recording is complete. Sound Recorder is limited to recording sixty seconds at a time. 5. Choose File: Save&. In the Save & dialog box, you can also dick on the Change button to set the sound quality at the desired level. The default file type is .wav, which can be read direcrly by most browsers. 6. Save the file in your resources folder. You may want to experiment with the microphone's positioning and its volume levels before trying to record something important. Set ­ting the microphone too near the source of  the sound or  too far from it can compromise sound quality. Setting the microphone volume too high can exceed the microphone's ability to capture sound, and setting it too low can make the audio recording difficult to hear. To change microphone volume levels, dick on Start: Programs: Accessories: Enter­tainment (or Multimedia): Volume Control, and move the microphone slider up or down. 
Capturint Video As you might expect, capturing and digitizing video is more complicated, and the particular steps required depend on the camera, card, and digitizing software used. Because of the considerable variation in hardware and software, it is not possible to cover specific steps here. But in general the process works like this. Rather than import­ing the video directly into the computer, as with a microphone, video cameras record video first on tape. This tape must be connected to the computer, typically from the video camera itself or a VCR, and replayed so the computer can digitize the video. Usually, this involves plugging a cable between the video camera and the video capture card or Fire Wire port on the computer, running the software that generally comes with video capture cards, and playing the tape in the video camera. 
Editing Audio and Video With additional software, you can edit audio and video files to alter their quality, size, and length, as well as to cut out or splice together sec­tions. Most audio and video editing software will also handle the record­ing process with much more flexibility. Software for editing audio is relatively common, and much of it is sold as shareware, which means you can download the software on trial 
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and send in a payment later if you decide to keep it. Visit the book web site for information about a variety of audio editing software you may want to download and tty out. Because shareware is often created by small companies, each program is usually unique; read the software documentation for specific instructions on how to use each program. Software for editing video is considerably more expensive, but pro­grams such as Adobe Premiere, Apple iMovie, and Apple Final Cut Pro have put video editing into the range of amateurs and schools. Video editing software allows cutting and splicing video dips, and it provides the means for special effects such as transitions between dips and on­screen text animation. 
Formatting Audio or Video for the Web Audio and video editing programs also allow saving in formats that can be used on the Web. The wide variety of these formats, however, can make formatting audio and video for the Web somewhat complicated. Figure 4.9 gives a basic listing of the most common formats. Of the file types listed here, most can be linked directly ro web pages. Actually viewing or hearing the clip, however, requires that the 
Extension Name Media type Plug-in or Player required 

.wav Microsoft Wave Audio QuickTime, RealMedia, 
or Windows Media 

.ail, .snd Macintosh AIFF Audio QuickTime, RealMedia, 
or Windows Media 

.ra RealAudio Audio RealMedia 

.wma Windows Media Audio Windows Media 
Audio 

.mp3 Moving Pictures Audio QuickTime, RealMedia, 
Experts Group (MPEG) or Windows Media 

.rm RealMedia Audio/video RealMedia 

.mov Apple QuickTime Audio/video QuickTime 

.avi Video for Windows Video QuickTime, RealMedia, 
or Windows Media 

.wmv Windows Media Video Video Windows Media 

.mpg or Moving Pictures Video QuickTime, RealMedia, 

.mpeg Experts Group (MPEG) or Windows Media 

FIGURE 4.9 Audio and Video File Fonnats 
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browser be equipped with a free plug-in or player such as RealMedia, Win­dows Media) or QuickTime to play. Fortunately, such programs are very common) and they're easy to download. It's a good idea to include on your page a link to the appropriate plug-in site so users can download the appro­priate plug-in or player if they don't already have it installed. Most of the file types listed require the user of the web page to download the entire sound file before it starts playing. Files saved as RealMedia or Rea!Audio (.rm, .ra), Windows Media (.wma, .wmv), and Apple Quick Time (.mov), however) can be transmitted by a process called streaming, which means that the file can start playing on the fly­while it is still being downloaded. Preparing audio or video for stream­ing requires extra software to encode the sound for web transmission, and the three companies currently offering competing formats-Real Networks, Microsoft, and Apple-also offer encoding software so users can prepare files for streaming. This software (respectively, RealMedia Producer™, Windows Media Encoder™, and Quick Time Pro™) con­verts a source audio or video file into the appropriate file format and adjusts the quality, speed, and compression of the file for the best trans­mission through the Web. Basic versions of RealMedia Producer and Windows Media Encoder are currently available as free downloads, but Quick Time Pro and the fully featured versions of RealMedia Producer and Windows Media Encoder must be purchased. Because these com­peting products use different methods, be sure to consult the user doc­umentation for instructions on encoding content for streaming. Choosing which format to use also depends on whether viewers are going to access the audio locally or download it from a server. If the lat­ter, the choice of format depends on what server software is available for the web page to rely upon. Check with your web host to find out what formats generally work best in your situation. 
Inserting Audio and Video in Web Pages Actually presenting audio and video in a web page is a bit more com­plicated than the page creation techniques discussed thus far, but it can be as simple as creating a basic link. The two current methods for including audio or video in a web page are as follows: • Making a link from a web page to an audio or video clip. When a reader clicks the link, the browser opens the appropriate media player (QuickTime, RealMedia, or Windows Media) and starts the 
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and send in a payment later if you decide to keep it. Visit the book web site for information about a variety of audio editing software you may want to download and try out. Because shareware is often created by small companies) each program is usually unique; read the software documentation for specific instructions on how to use each program. Software for editing video is considerably more expensive, but pro­grams such as Adobe Premiere, Apple iMovie) and Apple Final Cut Pro have put video editing into the range of amateurs and schools. Video editing software allows cutting and splicing video dips, and it provides the means for special effects such as transitions between clips and on­screen text animation. 
Formattin!! Audio or Video for the Web Audio and video editing programs also allow saving in formats that can be used on the Web. The wide variety of these formats, however, can make formatting audio and video for the Web somewhat complicated. Figure 4.9 gives a basic listing of the most common formats. Of the file types listed here, most can be linked directly to web pages. Actually viewing or hearing the clip, however, requires that the 
Extension Name Media type Plug-In or Player required 

.wav Microsoft Wave Audio QuickTime, RealMedia, 
or Windows Media 

.aif, .snd Macintosh AIFF Audio QuickTime, RealMedia, 
or Windows Media 

.ra RealAudio Audio RealMedia 

.wma Windows Media Audio Windows Media 
Audio 

.mp3 Moving Pictures Audio QuickTime, RealMedia, 
Experts Group {MPEG) or Windows Media 

.rm RealMedia Audio/video Rea!Media 

.mov Apple QuickTime Audio/video QuickTime 

.avi Video for Windows Video QuickTime, RealMedia, 
or Windows Media 

.wmv Windows Media Video Video Windows Media 

.mpg or Moving Pictures Video QulckTime, RealMedia, 

.mpeg Experts Group {MPEG) or Windows Media 

FIGURE 4.9 Audio and Video File Fo,mats 
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browser be equipped with a free plug- in  or player such as Rea1Media, Win­dows Media, or QuickTime to play. Fortunately; such programs are ve1y common, and they're easy to download. It's a good idea to include on your page a link to the appropriate plug- in  site so users can download the appro­priate plug- in  or player if they don't already have it installed. Most of the file types listed require the user of the web page to download the entire sound file before it starts playing. Files saved as Rea!Media or Rea!Audio (.rm, .ra), Windows Media (.wma, .wmv), and Apple Quick Time (.mov), however, can be transmitted by a process called streaming, which means that the file can start playing on the fly­while it is still being downloaded. Preparing audio or video for stream­ing requires extra software to encode the sound for web transmission, and the three companies currently offering competing formats-Real Networks, Microsoft, and Apple-also offer encoding software so users can prepare files for streaming. This software (respectively, RealMedia Producer TM , Windows Media EncoderTM, and QuickTime Pro TM) con­verts a source audio or video file into the appropriate file format and adjusts the quality, speed, and compression of the file for the best trans­mission through the Web. Basic versions of RealMedia Producer and Windows Media Encoder are currently available as free downloads, but Quick Time Pro and the fully featured versions ofRealMedia Producer and Windows Media Encoder must be purchased. Because these com­peting products use different methods, be sure to consult the user doc­umentation for instructions on encoding content for streaming. Choosing which format to use also depends on whether viewers are going to access the audio locally or download it from a server. If the lat­ter, the choice of format depends on what server software is available for the web page to rely upon. Check with your web host to find out what formats generally work best in your situation. 
Inserting Audio and Video in Web Pages Actually presenting audio and video in a web page is a bit more com­plicated than the page creation techniques discussed thus far, but it can be as simple as creating a basic link. The two current methods for including audio or video in a web page are as follows: • Making a link fi'om a web page to an audio or video clip. When a reader clicks the link, the browser opens the appropriate media player (Quick Time, Rea!Media, or Windows Media) and starts the 
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audio or video clip. The media player generally appears as a sepa­rate window superimposed over the web page. • Embedding the audio or video clip in the web page. This method actu­ally inserts the player window and controls into the web page itsel( While embedding might seem the ideal technique, it's actually less reliable and more complicated because it requires special HTML cod­ing to work) and the coding is different for Netscape and Internet Explorer, as well as for each of the various file types and plug-ins avail­able. FrontPage, however, does includes a command (Insert: Active Ele­ments: Video) that will automatically embed a video in a page. Linking to audio or video, however, is relatively straightforward. To make a link to an audio or video dip in Netscape Composer, follow these steps: 1. Select the words or image you want to make a dickable link. 2. Click on the Link button in the toolbar. 3. Click on the Choose file button. You'll see a box that looks pretty much like an Open dialog box. 4. Navigate to your resources folder (you should keep your audio and video files in your resource folder along with all your other files). 5. Beside Files of type, select All Files. This will allow you to see the audio or video files in your folder. 6. Double-dick on the file name for the audio or video file you want to link to. 7. Click on the OK button in the Link dialog box. W hen you preview the web page in the browser, dicking on the link will start the appropriate player (Quick.Time, Real Media, or Win­dows Media) to play the clip. The player will open up a new window on top of the web page. When the dip finishes playing, you can close the player window to get back to the web portfolio. 
Slide Presentations Microsoft PowerPointTM has become a common way for people to prepare electronic slide shows for oral presentations, You may already have completed PowerPoint presentations for classes or a professional 
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conference. Including an HTML version of such a presentation in your web portfolio is relatively easy. PowerPoint allows you to create a series of slides that can be shown through a data projector or a computer monitor to an audience. When you save an HTML version of your presentation, Power Point makes a GIF of each slide, creates a web page for each slide to appear on, and builds a navigation bar so people can make their way through the pre­sentation on their own (see Figure 4.10). To create an HTML version of a PowerPoint presentation, follow this procedure: 1. Open your presentation in PowerPoint. 2. From the File menu, choose Save AB Web Page. If you are using PowerPoint 97, the program will walk you through a variety of options for creating the HTML version of your presentation. If you are using Power Point 2000 or later, you'll see a Save AB dialog box. Follow these steps to continue: 1. Click on the Tools menu in the Save AB dialog box and choose Web Options. Here you can specify the layout and navigation elements 
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FIGURE 4.10 HTML PowerPoint Presentation 
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for your HTML slides. You may want to experiment with a vari­ety of the included options. 2. When you finish making your choices in Web Options, click OK. 3. Navigate to your resources folder in the Save As dialog box. 4. In the File Name text box, type in a file name for HTML presen­tation. 5. Click the Save button. The program creates an HTML page and slide for each PowerPoint slide as well as navigation elements. It places an index page file in the resources folder, but it creates a new subfolder in your resources folder for all of the other image and HTML files associated with the presentation. To link the new HTML presentation to a web portfolio, follow this process: 1. In Composer or another web page editor, open the page on which you want the link to appear. 2. If you haven't already done so, type the text or insert the image you want people to click to go to the presentation. 3. Select the link text or image and dick on the Link button. 4. Type in the file name for the presentation index page file and press OK If you can't remember what file name you chose, you can also click on the Choose File (or Browse) button and select the presen­tation index file from your resources folder (it will be listed under the same file name you specified when saving the presentation for the Web). Remember that when you upload the web portfolio, you will need 
to upload not only the HTML index file, but also the subfolder of graphics and attached files that PowerPoint created. 

Conclusion 

Using multimedia in your web portfolio can be challenging, but it's also exciting 

for both writers and readers. You get to exercise your creativity, designing a web 

portfolio with personality and an individual flair. Your audience gains the plea­

sure of seeing something new and interesting. 

Once again, be sure to check with your school's technology staff to find out 

what support they can give you in creating multimedia elements for your portfolio. 






